
What’s New for
Avid® Media Composer® v6.5

Avid Symphony™ v6.5
Avid NewsCutter® v10.5

New Features

The following lists what’s new for the current editor release.

Feature Description For More Info

Remote Editing Avid Interplay Sphere introduces support for 
Windows® based, NewsCutter and Media 
Composer remote editing systems connected 
to an Interplay environment using a 
high-bandwidth communications link. This 
allows you to access and edit assets hosted at 
the facility from the field in real time. You 
can efficiently send assets from the field back 
to the facility.

See the Interplay Sphere Remote 
News Editing Workflow Guide. 

Audio Keyframe 
Enhancements

You can now select multiple audio keyframes 
on the Timeline and copy them to a different 
area of the same clip or to different clips.

See “Audio Keyframe 
Enhancements” on page 3.

Relink of QuickTime AMA 
files

Previously, if you wanted to relink to multiple 
files, the system prompted you for the 
location of each file, one at a time. With this 
release, if you point to the folder location 
where the file(s) you want to relink to exist, 
the system will relink to the files in the new 
folder.

See “Relinking to QuickTime 
AMA Files” on page 7.

Activating and Deactivating 
I/O Hardware

This feature allows you to enable and disable 
Avid Nitris DX and Mojo DX hardware and 
3rd party Open I/O hardware. 

See “Activating and Deactivating 
I/O Hardware” on page 7.
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Audio Punch-In Changes This release includes Audio Punch-In support 
for Open I/O devices. 

See “Audio Punch-In Changes” on 
page 8.

Dragging Nonadjacent 
Segments

You can now drag nonadjacent clips in the 
Timeline.

See “Dragging Nonadjacent 
Segments” on page 10.

64 Voices The editing application now supports 64 
voices.

See “Support for 64 Voices” on 
page 11.

Edit Titles in Timeline You can revise an existing title in the 
Timeline without having to go into Effects 
mode.

See “Revising a Title in a 
Sequence” on page 11.

Dynamic Relink to AMA 
Clips

Avid editing systems running in an Interplay 
Sphere environment now have dynamic relink 
available for AMA clips. With dynamic 
relink enabled, the editing system will 
automatically relink AMA clips to managed 
media when it becomes available on an 
indexed Interplay storage. Managed media is 
always chosen over linked AMA media.

For more info, refer to “Interplay 
Sphere and Dynamic Relink” in 
the Help.

AS-02 Support The Avid editing application supports the 
AS-02 specification.

This release also includes AS-02 support for 
DNxHD.

See “Working with Export 
Volumes” on page 12.

DNxHD 100 With this release of the Media Composer 
family of products, Avid supports DNxHD 
100.

See “Resolution Specifications: 
HD” on page 17.

JPEG 2000 With this release of the Media Composer 
family of products, Avid supports the JPEG 
2000 (J2K) resolution. 

See “Resolution Specifications: 
HD” on page 17.

See “Resolution Specifications 
SD: J2K” on page 24.

Adding the Active Format 
Description (AFD) to the 
data track.

With this release, you can add the Active 
Format Description metatdata for a sequence 
to the data track. 

See “Adding the Active Format 
Description to the Data Track” on 
page 24.

Removed VC1 Support Support for VC1 has been removed.

SearchData folder location 
option

When creating a new project, you can choose 
the location for the SearchData folder.

See “Setting the Location of the 
SearchData folder” on page 27.

Feature Description For More Info
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Audio Keyframe Enhancements

Enhancements have been made that affect how you select, cut, copy, paste and move audio 
keyframes. You can select audio keyframes in the Timeline and copy them to a different area 
of the same clip or to different clips. You can also choose to copy either just Automation Pan 
or Automation Gain keyframes.

Creating a New Keyframe

A new keyframe can be created with a keyboard shortcut and clicking in the Timeline.

To create a new keyframe:

1. Click the Clip Volume/Pan button in the Track Control panel, and select the Volume or 
Pan.

2. Enable the Keyframe Selection button.

3. Click in the Timeline in the area where you want to create a keyframe or click on an 
already existing keyframe curve/line in the Timeline.

4. Press Ctrl+Shift (Windows) or Command+Shift (Macintosh) and click on the track.

A keyframe is created.

Copy and Pasting Audio Keyframes

You can easily copy and paste audio keyframes in the Timeline.

Stop Indexing An option has been added to the Find window 
that allows you to stop the indexing process.

See “Stop Indexing” on page 28.

See Searching for a Clip or 
Sequence with Text Find or Using 
PhraseFind.

Relink Updates Changes have been made to the Relink 
dialog.

See “Relink Updates” on page 29.

AMA Settings Update The option “Automatically AMA-link to 
volumes” has been added to the Volume 
Mounting tab of the AMA Settings. This 
setting is selected by default.

See “AMA Volume Management” 
on page 33.

QuickTime 7.7.2 Support The editing application supports QuickTime 
v7.7.2.

Feature Description For More Info
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Copy and Paste Individual Keyframes

To copy and paste individual keyframes:

1. Click on the keyframe to select it.

The keyframe highlights pink. 

2. Shift+click to select multiple keyframes. 

3. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy the audio keyframes to 
the clipboard.

4. Either Mark IN or Mark OUT or move the blue bar to the area in the audio track where 
you want to paste the audio keyframes. You can also select another audio track where 
you want to paste the keyframes.

5. Press Ctrl+V (Windows) or Command+V (Macintosh) to paste the individual 
keyframes. 

n Pressing Shift+click on an already selected keyframe, deselects the keyframe. Clicking 
anywhere else in the Timeline deselects the keyframe(s) if the Smart Tool is enabled. Clicking 
the Timecode ruler in the Timeline does not affect selection unless“Clicking the TC Track or 
Ruler Disables Smart Tools” is checked in the Timeline Settings.

Copy and Paste by Lassoing an Area of Audio Keyframes

To copy and paste by lassoing an area of audio keyframes: 

1. Lasso the area that contains the keyframes you want to copy.

n If a keyframe is already selected, Shift + lasso only selects more keyframes even if a whole 
segment or transition is within the lasso.

n Shift+lasso deselects any currently selected keyframes.

2. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy the audio keyframes to 
the clipboard.

3. Either Mark IN or Mark OUT or move the blue bar to the area in the audio track where 
you want to paste the audio keyframes. You can also select another audio track where 
you want to paste the keyframes.

4. Press Ctrl+V (Windows) or Command+V (Macintosh) to paste the keyframes.

The keyframes are pasted in the Timeline.
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Copy and Paste a Whole Region or Marked Region of Audio Keyframes

To copy and paste audio keyframes:

1. Do one of the following: 

t Select an entire audio segment.

t Select the audio region with Mark IN and Mark Out

2. Press Ctrl+C (Windows) or Command+C (Macintosh) to copy the clip and audio 
keyframes to the clipboard. 

3. Either Mark IN or Mark OUT or move the blue bar to the area in the audio track where 
you want to paste the audio keyframes. You can also select another audio track where 
you want to paste the keyframes.

4. From the Edit Menu select Paste Audio Keyframes or use the shortcut Shift+Ctrl+V 
(Windows) or Shift+Command+V (Macintosh).

A dialog opens asking you to choose the type of keyframes to paste.

5. Select either Automation Gain or Automation Pan. Or choose both.

6. Click OK. 

The keyframes are pasted in the Timeline.

Moving Keyframes in the Timeline

A number of enhancements have been made that make it easier to move audio keyframes. 
You can now move a range of audio keyframes up and down in volume. You can nudge 
individual keyframes and you can horizontally drag individual keyframes or a group of 
keyframes. 

To nudge individual keyframes:

1. Select the keyframe you want to move.

2. Press Shift+Command (Macintosh) or Ctrl+Shift (Windows) + up or down arrow keys 
to move the keyframe in 1dB increments. 
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3. Press Shift+Command (Macintosh) or Ctrl+Shift (Windows) + left or right arrow keys 
to move the keyframe left or right in one frame increments.

To move a range of keyframes up and down in volume:

1. Either lasso the range of keyframes or Shift+click the range of keyframes you want to 
move. 

2. Click on any single keyframe in the range and move up and down. The entire range 
moves.

To move a range of keyframes in time:

1. Lasso the range of keyframes or Shift+click the range of keyframes you want to move.

2. Press Option+drag (Macintosh) or Alt+drag (Windows) to move the entire group of 
keyframes horizontally in the Timeline. 

Removing Hidden Keyframes

When you edit or trim an audio track that contains keyframes, there may be keyframes that 
are hidden to the left or right of the remaining part of the clip.You can easily remove hidden 
keyframes.

To remove hidden keyframes:

1. Mark the area that contains the keyframes you want to remove. (If you do not select a 
marked area, all hidden keyframes will be removed.) 

2. Open the Audio Mixer Tool. Ensure you are in Auto Mode. 

3. Select the Audio Mixer Tool Fast menu (hamburger menu). 

4. Select one of the following:
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t Remove Hidden Volume Automation On Track to remove all the volume 
automation keyframes

t Remove Hidden Pan On Track to remove all the Pan keyframes

t Remove Hidden Pan/Volume on Track to remove all the Pan and Volume keyframes

You can also right+click at the transition and choose Delete Hidden Left, or Delete 
Hidden Right to remove the hidden keyframes to the left or the right of the transition.

Relinking to QuickTime AMA Files

This feature is helpful when you have a group of linked clips that were moved to a different 
folder or drive. You can relink the clips to the new location. 

To relink to AMA QuickTime file(s):

1. Select the file(s) you want to relink by doing one of the following:

t Click a single file

t Shift+click to select multiple adjacent files

t Ctrl+click (Windows) or Command+click (Macintosh) to select multiple 
nonadjacent files

2. Right-click and select Relink to AMA File(s).

The Select file(s) to relink AMA clip dialog box opens asking you to locate the new 
file(s).

3. Locate the folder where the files exist. 

4. Click OK. 

The clips appear linked in the bin. If all the clips you wanted to relink to do not reside in 
the selected folder, you will receive a dialog indicating how many files were not 
relinked. Open the Console window to see the name of the file or files that were not 
relinked.

n If the new file is not compatible with the clip in the bin (it does not have the same duration, 
edit rate or number of tracks), the clip in the bin retains its original link.

Activating and Deactivating I/O Hardware

The editing application includes a hardware toggle button in the Timeline. This allows you 
to switch between hardware and software editing modes. The hardware toggle button 
appears in the Timeline if I/O hardware is attached when you launch the editing application. 
This includes Avid Nitris DX and Mojo DX hardware and 3rd party Open I/O hardware. 
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This feature allows you to enable and disable the hardware for use with other software, for 
example After Effects. This also allows you to access certain software only features such as 
Full Screen Play. 

n The editing application will automatically release the hardware if you switch to another 
application. It will be reactivated when you switch back to the editing application.

Activating and Deactivating I/O Hardware

If the Toggle Hardware button is enabled, the I/O hardware is active. If the Toggle Hardware 
button is disabled, the I/O hardware is inactive.

To activate the I/O hardware:

t Click the Toggle Hardware button until it is active. The button is gray when hardware is 
active. This puts the editing application in Hardware mode. 

To deactivate the I/O hardware:

t Click the Toggle button until it is inactive. The button has a red circle and line through it 
when inactive. This puts the editing application in Software mode. 

Certain settings and buttons in the editing application change depending upon which mode 
you are in. For example, the Toggle Client Monitor button is disabled when the editing 
application is in Software mode. And you have access to additional Audio Project Output, 
Video Input and Video Output options when the editing application is in Hardware mode. 

n The I/O third party vendors are working on updating their plugins to work with the Toggle 
Hardware feature. Your current third party plugins will work properly with this version of 
the editing application, but if you try and use the Toggle Hardware button without updated 
plugins, you might need to reboot the system to reacquire your hardware.

Audio Punch-In Changes

This release incorporates the following Audio Punch-In changes: 

• Audio Punch-In support for Open I/O devices

• Host audio input for Audio Punch-In
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Audio Punch-In Support for Open I/O Devices

If your Open I/O device allows you to record and play simultaneously, you can perform an 
Audio Punch-In. If your Open I/O device does not support simultaneous record and play, 
you can use Host audio input for Audio Punch-In. Check with your 3rd party vendor to see if 
they support simultaneous record and play.

By clicking on the Punch-In monitoring button in the Audio Punch In tool, you can choose 
the following monitoring options:

• On - allows for IN to OUT audio monitoring during audio punch-in.

• Off - turns off IN to OUT audio monitoring during audio punch-in. When monitoring is 
off, the icon in the Punch-In tool changes to indicate punch in monitoring is off. For 
example, this mode is useful when you want to use another device such as the Mbox to 
provide local passthrough.

• Automatic - Allows the editing application to detect if monitoring should be On or Off 
due to detected latency. Monitoring is not disabled if latency <100ms. If the editing 
application detects latency >100ms, monitoring is turned off. Note: You can choose to 
override this by setting the monitoring to On.

In some hardware configurations, audio monitoring during Punch-In will not be allowed at 
all because the hardware does not support it. In this case, the Punch-In tool indicates the 
monitoring is Off and you cannot override it.

Host Audio Input for Audio Punch-In

In previous releases, you could not select Host audio input for your audio Punch-In. With 
this release, you can now use Host Audio input for punch-in.
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To select the Host Audio for Audio Punch-In:

1. Open the Audio Punch In tool and set the Input Source to your host audio. Note: You 
can choose the Input Source in either the Punch-In tool, the Audio Project Settings Input 
menu, or in the Capture Tool.

- On a Macintosh system, the individual host input choices will appear in the 
Punch-In tool Input Source menu.

- On a Windows system, for example, you can choose Windows Mixer from the 
Audio Punch-in tool Input Source menu and then select the specific device in the 
Control Panel > Sound >Recording window. 

2. Perform your audio punch-in. For details on performing a punch-in, see “Recording 
Voice-Over Narration Using Audio Punch-In” in the Help.

Audio Tool Icon Change

The icon to open the Audio Tool from within the Capture tool and the Audio Punch-In tool 
has been updated. The new icon to open the Audio Tool resemble audio meters..

Dragging Nonadjacent Segments

In previous releases of the editing application, you could not drag nonadjacent segments in 
the Timeline. The editing application would beep if you tried to move them. With this 
release you can drag nonadjacent segments in the Timeline. You must be in Overwrite mode 
to drag the segments. 

To drag nonadjacent segments:

1. Make sure you are in Lift/Overwrite mode by selecting the Lift/Overwrite button in the 
Smart Tool. 

2. Select the nonadjacent segments that you want to move.



Support for 64 Voices

11

3. Move the segments to the desired location.

Support for 64 Voices

The editing application supports 64 voices. Previously you could monitor up to 16 voices. A 
voice is a discrete audio stream that you send from an audio track to physical audio outputs, 
such as speakers or output channels. Typically, any audio channel for a track in your 
sequence uses a single voice. Mono audio clips use a single voice. A stereo clip uses two 
voices, and a 5.1 or 7.1 surround clip uses six or eight voices. Allowing for 64 voices is 
useful when working with multichannel tracks. 

Revising a Title in a Sequence
If you want to revise a title after you edit it into a sequence, you can choose to edit the title 
from the sequence.

To change a title in a sequence:

1. Place your cursor over the Title in the sequence that you want to edit.

2. Right-click and select Edit Title.

If the title is a Title Tool title, a dialog box opens, asking if you want to promote the title 
to Marquee. If you do not want to promote to Marquee, click no.

n You cannot edit titles that you promote to or create in Marquee with the Title tool. For 
information on Marquee titles and the Marquee Title tool, see the Avid Marquee Title Tool 
User’s Guide or the Avid Marquee Title Tool Help.

The Title tool or Marquee application will open and display the title.

3. Revise the title.
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4. Save the title.

Working with Export Volumes

The Avid editing application supports the creation of AS-02 Export Volumes. AS-02 is a 
specification for grouping multiple versions of program content into one single bundle. 
These bundles provide an efficient approach for working in a file-based environment.

For example, if you have a sequence with an English audio mix and a sequence with the 
same video but with a Spanish audio mix, creating an AS-02 Export Volume allows you to 
have all the program elements contained in a bundle without redundancy. The same video 
essence file can be the source for the both the English and the Spanish versions. This is 
useful if you want to save time on export and reduce used disk space.

The basic workflow is to create a new Export Volume Bin, copy the sequence or sequences 
you want to the Volume Bin, commit the assets in the Export Volume Bin, and then archive 
the AS-02 bundle folder. You can also link to an existing AS-02 bundle. 

The bundle folder structure is shown below. This is for reference only. These elements will 
be automatically created for you when you commit an Export Volume Bin.

• The Asset.mxf file is the sequence (version).

• The Manifest.xml file lists the creator information, creation date, version information 
and a list of all the files and folders in the bundle.

• The Shim.xml file is used as a template or settings file that constrains the rules for a 
specific facility. 

• The Media folder contains all the media files included in the bundle.

• The Extra folder contains a copy of the unflattened sequence (AAF composition only). 
The Extra folder can also contain any other files you want to keep with the bundle, such 
as scripts, graphics, etc. 
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Creating an Export Volume

You can create an export volume to place all program elements into a bundle.

To create a new export volume:

1. Select File > New Export Volume.

The Export Volume dialog box opens.

2. Select a Volume Type, for example AS-02.

3. Click Set to select the path where you want the Export Volume to reside.

4. Enter a name for the volume.

Asset

Asset.mxf

Manifest.xml

Shim.xml

Media

Extra
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5. Click Set to select the path to the shim template you want to use.

- AS-02 supports J2K, Uncompressed 10b RGB, DNxHD, AVCI, IMX and 
Uncompressed 8b for SD.

- All DNxHD templates are tuned to the DNxHD 220x family. That means depending 
on the project type, selecting a DNxHD template will export to a DNxHD 10b 
codec.

- AS-02 Shim templates for all supported resolutions are located in the Supporting 
Files folder.

- You can choose any one of these templates depending on the desired output 
codec/format.

- You can also create a folder named Default at the root of the AS-02 Templates 
folder where you can place custom templates. For example, you can duplicate the 
AS-02_Shim_DNxHD_1080i_59.94.xml found in the DNxHD folder, modify it (to 
a different audio sample rate or DNxHD resolution) and place the duplicate in the 
Default folder. This duplicated template will now be the default template for 
1080i59 projects. 

- DNxHD resolutions are supported except DNxHD 100 and DNxHD 36.

6. Click OK.

The Export Volume bin opens.

Left to right: Export Volume Type, Path to Asset folder, Properties button, Commit button
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Moving Assets to an Export Volume

You can move the desired assets to the Export Volume.

To move assets to the Export Volume:

1. Open the bin that contains the sequence or sequences you want to write to the Export 
Volume. 

2. Select and drag the sequence(s) to the Export Volume.

A copy of the sequence(s) appears in the Export Volume. 

n You can only drag sequences to an AS-02 Export Volume Bin. If you try to drag master clips, 
effects, titles, etc, you will receive a message indicating that some assets that you selected 
could not be dragged to the Volume Bin. If you receive this message, open the Console Tool 
to see the list of items that were not written.

Committing Assets to an Export Volume

Once you commit the assets, the sequence is flattened to the OP1b format, the video is 
encoded to the J2K codec and audio saved as PCM. 
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To commit the assets to the Export Volume:

1. Open the Export Volume that contains the sequence(s) to commit.

2. Click the Commit button to commit the assets to the AS-02 bundle.

The sequence along with its associated media files populate the Export Volume. 

Note the Media Status column indicates the committed status of each asset in the 
volume. Green indicates the asset is committed. Yellow indicates the asset is not 
committed. Red indicates the asset is offline.

Once the assets are committed, the following are written to the bundle folder:

- The sequence (version)

- The essence files

- The manifest (a file listing the creation date, creator, version information and a list 
of all the files and folders in the bundle.)

- The shim file (used as a template or settings file that constrains the rules for the 
specific facility)

- An AAF copy of the unflattened sequences(s) in the Extras folder

Archiving the AS-02 Bundle

Once you have committed the assets to the Export Volume, you can archive the AS-02 
bundle.



Resolution Specifications: HD

17

To archive the Assets Folder.

1. Locate the AS-02 bundle folder by accessing the path you set in step 4 of Creating an 
Export Volume.

2. Copy the AS-02 bundle folder to your archive server.

Linking to an existing AS-02 Bundle

You can open an existing AS-02 bundle.

To link to an existing AS-02 Volume:

1. Select File > Link to Volume for Export.

2. Select the folder where the AS-02 bundle resides.

3. Click OK.

4. A new volume bin opens with the AS-02 assets.

You can also choose to Link to AMA Volume if you want to open the assets as 
Read-only in a classic bin.

Resolution Specifications: HD
Your Avid editing application supports the capture, editing, and output of high-definition 
(HD) media in Avid DNxHD™, Avid DNxHD444, DVCPRO HD, (for Macintosh only) 
Apple® ProRes 422 and Apple ProRes 4444 resolutions. For information on support for 1:1 
(uncompressed) HD media, see “Support for Uncompressed HD Media” in the Help.

Avid DNxHD encoding technology delivers mastering-quality 8-bit or 10-bit HD media at 
standard-definition (SD) data rates and file sizes. 

Avid editing applications support editing and playback of J2K media. You can import, 
playback, transcode, and consolidate these resolutions. All J2K resolutions are encoded with 
variable bit-rate (VBR) encoding to meet a target, average bit-rate. Depending upon video 
content, the actual average rate will vary. The range of the bit-rate can be from 120 to 250.

The following table provides information about HD resolutions for interlaced and 
progressive media. HD resolutions are available only in MXF format. Unless otherwise 
specified in the resolution name, all resolutions are in the YCbCr color space. Avid 
DNxHD444 resolutions only appear when the HD project’s Color Space is set to RGB 709 
(1080p projects only).
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Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second 
(Mb/sec)

1:1 10-bit HD
1:1 HD
DNxHD 90 X
DNxHD 90
DNxHD 60
DNxHD 40
DVCPRO HD
XDCAM HD 50
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444 
J2K 720p
AVC-Intra 50

10
8
10
8
8
8
8
8
10
10
10
10
10
10
10
10

720p/23.976 1280 x 720

960 x720

23.976 442
354
90
90
60
40
100
50
100
59
88
41
18
132
60
50

1:1 10-bit HD
1:1 HD
DNxHD 90 X
DNxHD 90
DNxHD 60
DNxHD 45
DVCPRO HD
XDCAM HD 50
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 720p
AVC-Intra 50

10
8
10
8
8
8
8
8
10
10
10
10
10
10
10
10

720p/25 1280 x 720

960x720

25.00 440
352
90
90
60
45
55
50
100
61
92
42
19
138
65
50
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1:1 10-bit HD
1:1 HD
DNxHD 110 X
DNxHD 110
DNxHD 70
DNxHD 50
DVCPRO HD
XDCAM HD 50
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 720p

10
8
10
8
8
8
8
8
10
10
10
10
10
10
10

720p/29.97 1280 x 720 29.97 527
422
110
110
70
50
55
50
100
73
110
51
23
165
75

1:1 10-bit HD
1:1 HD
DNxHD 185 X
DNxHD 185
DNxHD 120
DNxHD 85
DVCPRO HD
XDCAM HD 50
ACV-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 720p
AVC-Intra 50

10
8
10
8
8
8
8
8
10
10
10
10
10
10
10
10

720p/50 1280 x 720

960 x720

50 879
704
175
175
115
85
110
50
100
122
184
84
38
275
125
50

Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second 
(Mb/sec)
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1:1 10-bit HD
1:1 HD
DNxHD 220 X
DNxHD 220
DNxHD 145
DNxHD 100
DVCPRO HD
XDCAM HD 50
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 720p
AVC-Intra 50

10
8
10
8
8
8
8
8
10
10
10
10
10
10
10
10

720p/59.94 1280 x 720 59.94 1105
884
220
220
145
100
100
50
100
147
220
101
45
330
150
50

1:1 10-bit RGB HD
1:1 10-bit HD
1:1 HD
DNxHD 175 X
DNxHD 175
DNxHD 115
DNxHD 80
DNxHD 36
DNxHD444 350 X
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 1080p
AVC-Intra 50

10
10
8
10
8
8
8
8
10
10
10
10
10
10
10
10
10

1080p/23.976 1920 x 1080

1440x1080

23.976 1591
994
795
175
175
115
80
36
350
100
117
176
82
36
264
120
50

Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second 
(Mb/sec)
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1:1 10-bit RGB HD
1:1 10-bit HD
1:1 HD
DNxHD 175 X
DNxHD 175
DNxHD 115
DNxHD 80
DNxHD 36
DNxHD444 350 X
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 1080p

10
10
8
10
8
8
8
8
10
10
10
10
10
10
10

1080p/24 1920 x 1080 24.00 1593
995
796
175
175
115
80
36
350
117
176
82
36
264
120

1:1 10-bit RGB HD
1:1 10-bit HD
1:1 HD
DNxHD 185 X
DNxHD 185
DNxHD 120
DNxHD 85
DNxHD 36
DNxHD444 365 X
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 1080p

10
10
8
10
8
8
8
8
10
10
10
10
10
10
10
10

1080p/25 1920 x 1080 25.00 1659
1037
829
185
185
125
85
36
365
100
122
184
85
38
275
125

Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second 
(Mb/sec)
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1:1 10-bit RGB HD
1:1 10-bit HD
1:1 HD
DNxHD 220 X
DNxHD 220
DNxHD 145
DNxHD 100
DNxHD 45
DVCPRO HD
XDCAM HD 50
DNxHD444 440 X
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 1080p

10
10
8
10
8
8
8
8
8
8
10
10
10
10
10
10
10

1080p/29.97 1920 x 1080 29.97 1989
1243
994
220
220
145
100
45
100
50
440
147
220
102
45
330
150

1:1 10-bit RGB HD
1:1 10-bit HD
1:1 HD
DNxHD 185 X
DNxHD 185
DNxHD 120
DNxHD 85
DVCPRO HD
XDCAM HD 50
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 1080i
AVC-Intra 50
DNxHD TR-120

10
10
8
10
8
8
8
8
8
10
10
10
10
10
10
10
10
8

1080i/50 1920 x 1080

1440x1080

25.00 1659
1037
829
185
185
120
85
100
50
100
122
184
85
38
275
125
50
120

Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second 
(Mb/sec)
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The data rate (bandwidth) for Avid DNxHD resolutions is calculated per second for each 
frame rate. For example, DNxHD 220 has a compressed data rate of 220 Mb/sec at 29.97 
fps. DNxHD 185, which is an equivalent resolution, has a compressed data rate of 
185 Mb/sec at 25 fps.

A good guideline for selecting a resolution is to use the Avid DNxHD resolution that 
matches the megabit data rate of the acquisition format. For HDCAM-originated material, 
for example, select DNxHD 145, which closely matches the data rate of HDCAM but 
provides better mastering results and uses significantly less storage. The following table 
compares Avid HD formats to the HDCAM format.

1:1 10-bit RGB HD
1:1 10-bit HD
1:1 HD
DNxHD 220 X
DNxHD 220
DNxHD 145
DNxHD 100
DVCPRO HD
XDCAM HD 50
AVC-Intra 100
Apple ProRes 422 MXF
Apple ProRes 422 HQ MXF
Apple ProRes 422 LT MXF
Apple ProRes 422 Proxy MXF
Apple ProRes 4444
J2K 1080i
AVC-Intra 50
DNxHD TR-145

10
10
8
10
8
8
8
8
8
10
10
10
10
10
10
10
10
8

1080i/59.94 1920 x 1080

1440x1080

29.970 1989
1243
994
220
220
145
100
100
50
100
147
220
102
45
330
150
50
145

Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second 
(Mb/sec)

Avid DNxHD 36 Avid DNxHD 145 Avid DNxHD 220 Sony HDCAM

Bit Depth 8-bit 8-bit 8-bit and
10-bit

8-bit

Sampling 4:2:2 4:2:2 4:2:2 3:1:1

Bandwidth 36 Mb/sec 145 Mb/sec 220 Mb/sec 135 Mb/sec
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Resolution Specifications SD: J2K

Avid editing applications support editing and playback of J2K media. You can import, 
playback, transcode, and consolidate these resolutions. All J2K resolutions are encoded with 
variable bit-rate (VBR) encoding to meet a target, average bit-rate. Depending upon video 
content, the actual average rate will vary. The range of the bit-rate can be from 120 to 250.

The following table provides J2K specifications by project type.

Adding the Active Format Description to the Data 
Track

Active Format Description (AFD) is a standard set of codes that can be sent in the video 
stream that carries information about the aspect ratio and the active picture characteristics. 
AFD information allows you to display the video of one aspect ratio on a display with 
another aspect ratio. When in an HD project, you can choose to add the AFD information to 
the data track.

Resolution Bits
Project 
Format Frame Size Frames/sec

Megabits per 
second (Mb/sec)

J2K NTSCi 10 30i 720 x 486 30 50

J2K PALi 10 25i 720 x 592 25 50

J2K NTSCp 10 30p 720 x 486 30 50
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To add the AFD to the Data Track:

1. Right+click the sequence to which you want to add the AFD and select Modify.

The Modify window opens.

2. Select Active Format Description.

The Modify window displays the Active Format Description options.
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3. Select the Active format information you want to include with the data track. The active 
format options change depending upon the selected Coded Frame. A graphical 
representation of the active format is displayed in the Modify window to show you how 
the active format area will be displayed.

The table below shows the selectable active format options.

4. Click OK.

Option Description

Active Format • 0000 Undefined

• 0100 Box >16:9 (center)

• 1000 Center

• 1001 4:3 (center)

• 1010 16:9 (with complete 16:9 image protected)

• 1011 14:9 (center)

• 1101 4:3 (with alternative 14:9 center)

• 1110 16:9 (with alternative 14:9 center)

• 1111 16:9 (with alternative 4:3 center)
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A new data track will be created if one is not already present in the sequence. You will 
receive a dialog indicating that a data track will be created. The data track appears 
empty. This data track must be present and monitored during output in order for the 
AFD value to be inserted. If you delete this data track, the AFD value is also deleted.

Setting the Location of the SearchData folder

In previous releases, you could not change the location of the SearchData folder. When you 
created a new project, the SearchData folder defaulted to your Projects folder. When you 
were in an ISIS environment the default was the Project client (computer name) folder. With 
this release, when creating a new project you can choose the location of the SearchData 
folder.

To choose the location of the SearchData folder:

1. Start the editing application.

2. In the project window, select New Project.

The New Project dialog opens.

3. Select the Search Data Folder menu. Select either Default, Local Default, or Other. To 
change the location from the Default options, select Other.

4. Choose the folder where you want the SearchData folder to reside.
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5. Click OK.

A subfolder with the project name is created in the folder you selected in step 4.

n You can also set the SearchData folder in the Settings tab of the Find Window.

Stop Indexing

If during a Find or PhraseFind search you decide that you want to stop the indexing process, 
an additional option has been added to the Find window to allow you to stop this process.

To stop the indexing process:

1. During the search, the Find window is open. Select the Settings tab.

2. Click the Stop Indexing button.

The indexing stops and the button changes to Start Indexing. The indexing remains off 
until you click Start Indexing.
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Relink Updates

The Relink dialog has been updated to include more options by which you can Relink. You 
can relink based on any column in a bin. These column names can be used as the source 
name for the relink.
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Sample Relinking

The following is an example of using the updated Relink options. In the example relink steps 
below, the original clips are highlighted blue in the bin and Timeline and target clips are 
highlighted in red. The clips in each bin share a common name. And the Start timecode for 
the original clips matches the Auxilary timecode to the clips in the other bin. The relink is 
done by choosing the Start timecode of the original clips and the Auxilary timecode of the 
target clips. 

Option Description

Relink by:

Timecode Allows you to relink to Start, Aux TC1-TC5, or Sound 
Timecode.

Source Name Allows you to relink to a number of relink options:Tape 
Name or a Source File ID, Tape Name or Source File Name, 
Keynumber, Name, Camroll, Labroll, Disk Label, More. 
Click the More option to see the list of additional column 
name options.

Ignore extension If selected, the system compares names and ignores 
extensions (for example, File1.jpeg can be relinked to 
File1.png)

Ignore characters after last 
occurrence

Select this option to have the system ignore the characters in 
the name after the last occurrence of the text you enter.

Match case when comparing 
tape and source file names

Makes tape name and source file name search case sensitive.

Target (if Different from 
Original)

Select this option if you want to set different Relink by 
options than were set for the original relink. allow you to set 
different source information to the target you are trying to 
link to. For example, if a source tape name has been 
encoded into a different column name by a third party 
application, you can set the target relink option accordingly.
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To Relink by:

1. Select the clips in the bin to which you want to relink. (The clips highlighted in red in 
this example.)

2. Select the sequence you to which you want to relink the clips.

3. Select Clip > Relink.

The Relink dialog opens.
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4. Click Selected items in ALL open bins.

5. Set the Original Timecode to Start. 

6. Click Target (if different than Original).

7. Set the Target Timecode to Auxillary TC1.

8. Set Original Source Name to Name and Target Source Name to Name.

9. Click OK.

A new sequence with the relinked media appears in the bin. 
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AMA Volume Management

AMA Volume Management is now enabled full time. This means that AMA is always on. 
Therefore, the option “Enable AMA Volume Management” has been removed from the 
AMA Settings.

This setting was originally implemented to help preserve the non-AMA XDCam and P2 
workflows. While these workflows are still available, this setting is no longer needed. To 
enable the non-AMA P2 and XDCAM workflows for importing media, click “Enable 
Legacy (pre-AMA) P2 and XDCAM” in the AMA Settings. 
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In addition, there is a new option to allow or prevent volumes/disks from being 
automatically mounted. In previous releases, when you inserted media into a device it would 
automatically populate a bin. Now, you have the option to enable this functionality under the 
Volume Mounting tab of AMA settings. With “Automatically Link to AMA Volumes” 
disabled, you can load media without the clips appearing in a bin. 

n You should not mix workflows. Either use the AMA method or use the traditional 
import/batch import method.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid 
Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product 
may only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents; 5,440,348; 5,528,310; 
5,557,423; 5,577,190; 5,584,006;  5,724,605; 5,726,717; 5,745,637; 5,752,029; 5,754,851; 5,812,216; 5,905,841; 5,959,610, 
6,057,829, 6,091,778, 6,141,691, 6,160,548, 6,201,531; 6,269,195; 6,330,369; 6,336,093, 6,353,862, 6,404,435; 6,407,775, 
6,426,778; 6,477,271, 6,512,522; 6,546,190; 6,552,731, 6,570,624; 6,571,255, 6,583,824; 665,450; 6,687,407; 6,704,445; 
6,728,682, 6,747,705; 66,763,134,6,766,063; 6,791,556; 6,810,157, 6,847,373; 6,871,003; 6,871,161, 6,907,191; 6,928,187, 
7,043,058; 7,081,900; 7,103,231; 7,145,567; 7,266,241, 7,280,117; 7,403,561; 7,433,519; 7,441,193, 7,545,957; 7,671,871; 
7,684,096; 7,725,812; 7,729,423; 7,916,363 ; 7,930,624; 7,973,800; 8,023,568; 8,082,226; 8,154,776; and D515,095, 
D396,853. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 
0674414; 0752174; 0811290; 0811292; 0811293; 0857293; 0976108; 0988756; 1050048; 1068734; 1111910; 1173850; 
1629675. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid Media Composer may reproduce this 
publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or 
distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or 
educational services to others. This document is supplied as a guide for Avid Media Composer. Reasonable care has been 
taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or 
typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of 
this document. Product specifications are subject to change without notice.

Copyright © 2012 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING 
THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY 
PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of 
the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any 
advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon 
Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 
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Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that 
the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to 
distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the 
suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this 
entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all 
copies of the supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be 
covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 
and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be 
liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or 
operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, 
special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s 
products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates 
has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”
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“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, 
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, 
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, 
Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, 
Axiom, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, 
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, 
Command|24, Command|8, Conectiv, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, 
Dazzle Digital Video Creator, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, 
Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, DPP-1, D-Show, 
DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, 
FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, 
iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, 
Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, 
iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, 
Luna, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, 
Massive Pack Pro, M-Audio, M-Audio Micro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, 
Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, 
Mix Rack, MixLab, Moviebox, Moviestar, MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, 
NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, 
Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, QuietDrive, 

http://www.apache.org/
http://jcifs.samba.org/
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Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, 
Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, 
SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, 
Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, 
SYNC I/O, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, 
Torq Xponent, Transfuser, Transit, TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, 
Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, 
X-Session, and X-Session Pro are either registered trademarks or trademarks of Avid Technology, Inc. in the United States 
and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.
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